Picture Archiver HELP IndexMenu Entries:
The File menu
The Database menu
The Record menu
The Image menu
The Comment menu



The "File" menu
This commands allows to work with files

Commands:

New... - creates new database

Open... - loads existing database
Directory... - makes and changes directory
Exit - leaves Picture Archiver



The "New" command

After the input of this command the "Database setting" dialog box is called . You should
enter a database name (up to 8 Latin characters), define the type of preview cards formed
by the Picture Archiver program (the "Color" and "Grey" fields), define whether the
preview cards would be formed in advance and saved on a disk (the "Save Cards" field),
whether initial images would be included into the Database or whether only the preview
cards would be saved in the database as a graphic information (the "Include Images" field),
enter the size of cards (the "Vertical size" and "Horizontal size" fields), key word names (the
"Key word names" field) and define whether key words would be displayed when looking
over the list of records (the "Show" field). Indications of a format are permissible in the key
word names. With this purpose in view you should include a format mark at the end of the
key word name in accordance with the following table:

%d - integer;

%f - floating point number.

If the format mark is not included the key word would be perceived as a string of characters.
Provided the images are included into the database it is necessary to select the image
compression mode after pressing the "Pack method" button. At present the compression is
supported in accordance with the LZW and JPEG technologies.

The LZW technology allows to compress initial images by 1.5-3-fold without a loss of quality.
The JPEG allows to compress initial images by 10-30-fold with a small loss of quality. When
choosing the JPEG technology you should enter a quality parameter. The required quality
parameter depends on the task being solved, the quality and type of initial images and it is
selected in an experimental way. The compression may considerably increase the time for
looking over, exporting and printing images, but it will allow you to save the space on a disk.
After filling up the above-mentioned fields it is necessary to check up a correctness of the
parameters entered and to press the "OK" button. The entered database description is
recorded on a disk, and for making the first record the "Record setting" dialog box is called .
Note: In case of selecting the "Do Not Include Initial Images" and "Do Not Save Cards"
modes simultaneously the Picture Archiver program may be used for saving a textual
information only.

Attention! It is urgently recommended to place every database is a separate directory.



The "Open" command

After the input of this command the "Open a File" dialog box is called . It is necessary to
choose a file out of the suggested ones in the dialog box by pressing a button on the mouse
while pointing out the file name and then pressing the "Open" button, after which the "List of
Records" containing the list of records of the open database will be displayed, and the name
of file with the open database will appear in the name of the Picture Archiver basic
window.



The "Directory" command



The "Database" menu

This set of commands allows to change the type of the database and to display the content
of the database.

Commands:

List - shows list of records

mages - shows preview cards

Edit - changes type of database

Link - transfers database into a single file
Unlink - transfers database into a set of files
Clear - unloads database

—




Menu "Record"
This set of commands allows to edit and modify database record

Commands:

Edit - edits the record currently displayed
Delete - deletes the record currently displayed
Add - adds a new record

Search - makes a record search

Next and Previous - lists the database
Update preview - rebuild all preview cards



Menu "Image"

This set of commands allows to display and export an image inluded in the record currently
displayed on screen

Commands:

View - displays the image stored in database
Print - prints the image

Export - exports the image in TIFF file format
Edit- inokes an image eitor




Menu "Edit"
Invokes an image eitor

After the input of this command an image editor is invoked, and Picture Archiver passes the
name of an image loaded into active window to this editor.

The editor must be registered in the PARC.INI file in the [DIRECTORIES] key:

[DIRECTORIES]

EDITOR=C:\PMAN15\PMAN.EXE



Menu "Comment"

This set of commands allows to export textual information stored in database in file and on
clipboard and to print it

Commands:

Print - prints comments

Export - save comment in file

Copy - places comments on the clipboard




The "Database setting" dialog box

After the input of this command the "Database setting" dialog box is called . You should
enter a database name (up to 8 Latin characters), define the type of preview cards formed
by the Picture Archiver program (the "Color" and "Grey" fields), define whether the cards
would be formed in advance and saved on a disk (the "Save Cards" field), whether initial
images would be included into the Database or whether the cards would be saved in the
database as a graphic information (the "Include Images" field), enter the size of cards (the
"Vertical size" and "Horizontal size" fields), key word names (the "Key word names" field)
and define whether key words would be displayed when looking over the list of records (the
"Show" field). Indications of a format are permissible in the key word names. With this
purpose in view you should include a format mark at the end of the key word name in
accordance with the following table:

%d - integer;

%f - floating point number.

If the format mark is not included the key word would be perceived as a string of characters.
Provided the images are included into the database it is necessary to select the image
compression mode after pressing the "Pack method" button. At present the compression is
supported in accordance with the LZW and JPEG technologies. The LZW technology allows to
compress initial images by 1.5-3-fold without a loss of quality. The JPEG allows to compress
initial images by 10-30-fold with a small loss of quality. When choosing the JPEG technology
you should enter a quality parameter. The required quality parameter depends on the task
being solved, the quality and type of initial images and it is selected in an experimental way.
The compression may considerably increase the time for looking over, exporting and printing
images, but it will allow you to save the space on a disk. After filling up the above-mentioned
fields it is necessary to check up a correctness of the parameters entered and to press the
"OK" button. The entered database description is recorded on a disk, and for making the first
record the "Record setting" dialog box is called .

Note: In case of selecting the "Do Not Include Initial Images" and "Do Not Save Cards"
modes simultaneously the Picture Archiver program may be used for saving a textual
information only.

Attention! It is urgently recommended to place every database is a separate directory.



The "Record setting" dialog box

After the input of this command the "Record setting" dialog box is called . Then it is
necessary to fill in the "Record name" and "Key words" fields. When filling in the "Key words"
fields it is necessary to pay attention to the format flags of key words . A retrieval of files
with images is accomplished through a selection of the file type and name with the help of
the mouse. After selecting a file it is necessary to press the button of the mouse two times
after which the name of the required file will appear in the "Selected files" window. If the
standard image is recorded in Clipboard then it could be attached to the record by pressing
the "Paste" button. A textual information (comments) is included into a record with the text
editor called by pressing the "Comment" button.

Attention! When editing a record and changing the contents of images included into the
record it is necessary to make sure that there are all the files mentioned in the "Selected
files" window in the working directory.



The "Open a File" dialog box



The "Change directiry" dialog box



The "List ..." command

After the input of this command the "List of Records" dialog box containing all the records of
the loaded database is called . Every line of the list consists of the record number, record
name and a number of key words, and at the same time only those key words appear in a
line of the list for which the "Show" parameter was entered in the "Database setting" dialog
box . For displaying the required record you should select it with the help of the mouse and
press the "Show" button.

Note: When a search mask is loaded (the filter flag in the name of the basic window) then
only records corresponding the mask are displayed.



The "Images" command

After the input of this command up to 28 Windows with images from the database appear on
the screen. The window names contain record numbers and names corresponding to the
images. If the number of images stored in the database is over 28 then the scroll bar
appears at the right side of the main window which allows to scroll images of the database.
For displaying a record corresponding any image it is necessary to bring the cursor to the
required image and press the left button of the mouse two times.

Note: When a search mask is loaded (the filter flag in the name of the main window) only
records corresponding to the mask are displayed.



The "Directory" command



The "Link"

After the input of this command the booted database is transformed from a set of files
containing a database descriptor, a textual and graphic information into a single file. At the
same time operations of editing the database and records are prohibited.



The "Unlink" command

After the input of this command the loaded database is transformed from a single file into a
set of files containing a database descriptor, a textual and graphic information with the MDB,
CMT and PRE extension correspondingly. At the same time operations of editing the
database and records are allowed.



The "Clear" command

After the input of this command all the buffers related to the booted database are cleared,
any operations with the database are prohibited.



The "Search" dialog box

After the input of this command the "Search" dialog box is called. The search for a required
record may be accomplished by the record number and name, by key words and by the
name of a file with an initial image provided initial images are included into the database.
For entering a search mask it is necessary to fill in the fields corresponding to the sphere of
search and to enter correlations by pressing the button against the corresponding field and
by selecting a correlation (>, <, =, <=, >=). When filling in the fields for a search it is
possible to use the "*" character for a designation of an unknown part of a word ("wild
card"), in this case the correlations will be ignored. The search is not accomplished for empty
fields. After filling in the search fields and entering the correlations it is necessary to press
the "OK" button. The results of the search are displayed on the screen in the form of a list of
records corresponding to the given search mask. The display of the required record on the
screen is accomplished by selecting the record and pressing the "Show" button. For saving
the search mask it is necessary to press the "Save" button, in this case the flag "filter" will
appear in the name of the Picture Archiver main window, and all the subsequent
operations will be realized only with records corresponding to the saved mask right up to the
running of the "Free filter" command of the "Database" menu.

Note: When saving the search mask all the editing operations are prohibited.



The "View" command

After the input of this command the selected image is displayed, and the dimensions of the
window with the image are defined by a free space of the memory of the computer.

Note: Provided initial images are not included into the database the running of this
command would not lead to a better visual perception in comparison with a visual
perception of a card when displaying the record.



The "Print setting" dialog box

After the input of this command the "Print setting" dialog box is called .The Picture
Archiver program allows to output images directly to a printer and also to prepare images
for printing in the clipboard or a file. When preparing images for printing and for outputting
images to a black-and-white printer it is recommended to choose the use of a raster of
images. After indicating the required dimensions, please, press the "OK" button, and the
image will be printed.



The "Print" command

After the input of this command the "Font" dialog box is called . It is necessary to choose a

font for printing and press OK button.
Note: It is best of all to choose a font for printing in an experimental way.



The "Export" command

After the input of this command the "Export" dialog box is called . You should choose the file
name and press OK button.



The "Export" command

After the input of this command the "Export" dialog box is called . It is necessary to choose
the type of a file being saved and to enter its name. After pressing the "OK" button the file
will be formed with the image in the format which was chosen

Note: Provided initial images are included into the database the image may be exported to
the RGB TIFF file and to the 8-bit halftone TIFF file. If initial images are not included into the
database then the image may be exported to the 8-bit halftone TIFF file and to the TIFF. BMP
and PCX files with a palette, and the number of colors in the file with a palette will be
defined by the number of colors in the card with the image.



